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1. 目的 

建立化学生物学协同筛选系统标准使用操作规程，使其被正确、规范地使用。 

2. 范围 

本规程适用于所有使用化学生物学协同筛选系统的用户。 

3. 职责 

3.1. 用户：严格按本程序操作，发现异常情况及时汇报设备管理员。                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                         

3.2. 设备管理员：确保操作人员经过相关培训，并按本规程进行操作。 

3.3. 文章致谢格式： 

根据学校指导意见，使用各校级平台仪器设备表征产生的科研成果必须致谢平

台。如果您在文章成果中使用了光谱、色质谱、磁共振波谱、全自动高通量设备以

及其他属于分子科学平台的仪器设备，请务必在文末致谢分子科学公共实验平台。 

英文文章致谢： 

①Acknowledgement: The author thanks (Dr. XXX from) Instrumentation and Service 

Center for Molecular Sciences at Westlake University for (the 

assistance/discussion/supporting in) … measurement/data interpretation. 

②Coauthorship on the resulting publications would be appreciated if our staff make 

technical contributions (including but not limited to critical sample preparation, novel 

experiment designation and comprehensive data analyzation). 

Affiliation address: "Key Laboratory of Precise Synthesis of Functional Molecules of 

Zhejiang Province, School of Science, Instrumentation and Service Center for Molecular 

Sciences, Westlake University, 18 Shilongshan Road, Hangzhou 310024, Zhejiang 

Province, China." 

中文文章致谢： 

① 致谢：感谢西湖大学分子科学公共实验室平台 XXX 博士(或者 XXX 老师)

在……表征或数据分析上提供的帮助。 

② 共同作者：如果分子科学平台老师在您课题组样品表征或文章发表上有重要技

术贡献（包括但不限于关键样品制备、新型实验设计和深度数据分析），我们感谢
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您将相关老师列为共同作者，作者单位地址如下：西湖大学，分子科学公共实验平

台，功能分子与精准合成浙江省重点实验室，杭州，310030，浙江。 

4. 高通量精准化学实验室安全管理规范 

4.1. 进入或离开实验室规定 

4.1.1. 进入实验室之前必须通过学校、中心和平台的安全考试或考核，严格遵守本

实验室的各项安全警示标识。 

4.1.2. 进入高通量精准化学实验室，请仔细阅读本实验室的安全管理规定。 

4.1.3. 进入实验室需穿戴实验服，严禁穿拖鞋、高跟鞋进入实验室，长发请束起。 

4.1.4. 进入实验室应了解消防器具与紧急逃生通道位置，实验室通道及消防紧急通

道必须保持畅通。 

4.1.5. 严禁将自己授权的门卡转借他人，一旦发现将进行禁用处理。 

4.1.6. 禁止将实验无关人员带入实验室。 

4.1.7. 严禁在实验室饮食、吸烟或随意走动。 

4.1.8. 夜间实验，需至少两人在场。          

4.1.9. 为保持实验室内环境温度及湿度稳定，进入实验室后保持实验室门窗关闭。

实验结束后，实验人员必须进行清场。最后离开实验室人员需检查水、电、

门窗等。 

4.1.10. 严禁戴手套接触门把手或电梯。禁止随意丢弃实验废弃物。 

4.1.11. 实验室应保持整洁，严禁摆放与实验无关的个人物品。 

4.1.12. 空压机及 UPS 所处房间应使用空调，要保持室内空气干燥，在潮湿的季节

应该除湿。至少每周一次检查除湿机有无积水。 

4.2. 实验操作规定 

4.2.1. 实验室内均为大型科研设备，有专人负责管理，未经培训人员，不得擅自上

机使用。化学生物学协同筛选系统的组成和培训部分较为复杂，请根据已

完成培训的内容使用相应仪器/系统，未培训部分，不得擅自使用/修改。 

4.2.2. 送样或自主上机的用户，均需使用大仪系统进行系统预约/登记。 
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4.2.3. 请严格按送样要求进行样品准备。由于样品问题造成仪器损坏或仪器配件更

换，无论独立上机或是委托测试，费用将由用户所在课题组承担；  

4.2.4. 请严格按仪器操作规程进行操作。实验过程中有任何不确定必须联系设备管

理员，自主上机因操作错误造成设备损坏的，该用户课题组也需承担相关

费用。 

4.2.5. 实验过程中如发现仪器设备发生异常状况、仪器报错、报警等，务必立即联

系设备管理员严禁擅自处理、调整仪器主要部件，凡自行拆卸者一经发现

将给予严重处罚。 

4.2.6. 仪器均为高压设备，使用仪器需严格遵守用电安全规定，严禁擅自更改电路

或切断仪器电源等相关危险操作。  

4.2.7. 实验室内的药品、试剂必须存放药品柜，并做好使用登记。 

4.2.8. 使用化学试剂或药品前，必须了解其物理化学性质、毒性及防护方法，使用

时必须配戴护目镜、手套等，做好个人防护。 

4.2.9. 非常规实验测试须设备管理员同意并指导方可进行。实验数据须通过学校数

据中心进行下载，禁止将个人 U 盘、移动硬盘等易带入病毒的存储设备与

各仪器工作站连接拷贝数据。数据存储下载操作过程中请务必仔细谨慎，

以避免误删或误修改他人实验数据或编写程序的情况发生。 

4.2.10. 垃圾、废液必须严格按标识进行分类，禁止将锐器、玻璃丢弃在常规垃圾箱

中。 

4.2.11. 自主上机用户须在预约时间内须使用本人的账号登陆基理系统进行仪器使

用；使用结束应做好仪器使用登记，如实记录仪器使用状态。 

4.3. 气瓶使用规定 

4.3.1. 首次使用实验室气瓶，须经实验室设备管理员培训指导。 

4.3.2. 请按实验室气瓶标识选择正确的气源。 

4.3.3. 打开气瓶，先确认管路已连接稳妥，禁止未接气路或气路未连接稳妥，开气

瓶减压阀。 
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4.3.4. 更换气瓶，首先确保减压阀关闭，且管路中气压排空归零，先用扳手拧松后，

再用手旋下管路。换气瓶，确认气瓶螺纹吻合后，先手紧气体管路，再用

扳手拧 1/8 圈左右。 

4.3.5. 开气瓶或更换气瓶，禁止站在减压阀出气口正前方。 

4.3.6. 测试过程中，请根据需要及时更换气瓶。使用者应根据气瓶使用情况，变更

气瓶使用牌状态“满瓶”“使用中”“空瓶”等。 

4.3.7. 气瓶应保持正立并固定。 

5. 高通量精准化学实验室仪器设备管理规范 

5.1. 预约与使用 

该仪器遵从学校“科研设施与公共仪器中心”对大型仪器设备实行的管理办法

和“集中投入、统一管理、开放公用、资源共享”的建设原则，面向校内所有教学、

科研单位开放使用；根据使用机时适当收取费用；并在保障校内使用的同时，面向

社会开放。 

该仪器的使用实行预约制度，请使用者根据样品的测试要求在学校 “大型仪器

共享管理系统”（以下简称大仪网）进行预约，并按照要求登记预约信息。根据预约

制度可登陆大仪网站即时预约机时，包括周末；寒暑假及国庆假期将另行通知。 

自主上机： 

1) 化学生物学协同筛选系统为整合系统，可整套系统使用，部分仪器也能单机

运行。具体培训时间根据所需仪器/系统的具体情况不同，申请培训前先与

设备管理员联系。 

2) 请在大仪网预约培训机时，培训时请携带纸质版仪器培训申请表。 

3) 由设备管理员进行现场培训。 

4) 培训后两周内，用户可在设备管理员指导下用实际样品进行上机测试，并按

自主上机计费；根据自身掌握情况，用户需在两周内进行上机考核，考核通

过的用户即获得自主上机权限，原则上一星期复考；未考核或考核不通过的

用户，需重新接受培训。 

5.2. 预约制度 
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为充分利用仪器效能、服务全校科研工作，根据测试内容与时间的不同，实验

室仪器需进行网上预约制度。自主上机用户需根据预约制度登陆大仪共享网站最少

提前 2 个工作日预约机时，包括周末；寒暑假及法定节假日请关注实验室实时通知。 

请严格遵守预约时间使用仪器，以免浪费机时。如需调换时间段，在设备管理

员同意下可与其他使用者协商。因故不能在预约时间内测试者，请提前 30 分钟取消

预约并通知设备管理员。恶意预约机时或有多次无故不遵守预约时间的用户，实验

室将进行批评教育、通报批评或取消上机资格等处罚。 

1) 校内使用者须经过设备管理员的实验操作培训，考核合格后方可上机使用； 

2) 实验开始时务必在实验记录本上登记，结束后如实记录仪器状态； 

3) 严禁擅自处理、拆卸、调整仪器主要部件。使用期间如仪器出现故障，使用

者须及时通知设备管理员，以便尽快维修或报修，隐瞒不报者将被追究责

任，加重处理；  

4) 因人为原因造成仪器故障的（如硬件损坏），用户课题组须承担维修费用； 

5) 本实验室所有原始数据不允许在仪器工作站上删改，尤其不允许用 U 盘与

移动硬盘直接拷贝。用户应根据要求通过科研仪器网/数据服务器传送下载

原始数据至本地电脑，以保存并做数据处理。 

6) 用户应保持实验区域的卫生清洁，测试完毕请及时清理台面，带走样品，设

备管理员不负责保管。 

使用者若违犯以上条例，将酌情给予警告、通报批评、罚款及取消使用资格等

惩罚措施。 

5.3. 培训考核制度 

校内教师、研究生均可提出预约申请，由设备管理员安排时间进行培训，培训

内容包括仪器使用规章制度、送样须知及安全规范、基本硬件知识、标准操作规程

（自主测试）及相应数据处理。 

预约时段 预约时间 测试内容 

周一至周五 09:00 至 18:00 不限制 化学生物学协同筛选系统 
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培训结束后，两周内培训者需管理人员监督下进行 5 次左右操作，培训者根据

自己的掌握程度，联系设备管理员进行上机考核。初级考核合格后，可在管理人员

监督下上机操作，一周后复考； 

实验室设备管理员认为培训者达到独立操作水平后，给予培训者授权在所允许

的可操作实验范围内独立使用仪器。如果因为人为操作错误导致仪器故障者，除按

要求承担维修费用之外，给予重考惩罚、培训费翻倍。 

对接受培训人员的核心要求： 

1) 了解仪器的基本原理及其应用的多学科背景知识； 

2) 熟悉化学生物学协同筛选系统中已接受培训的相应仪器/系统的组成及各部

分的功能及使用注意事项，严格遵守仪器部件的开关顺序，在突然停电时能及

时处理仪器并上报，关注仪器各部件有无异常； 

3) 熟练掌握化学生物学协同筛选系统中被培训的相应仪器/系统的软件使用，

严格按照标准操作规程操作，防止因人为操作不当造成仪器故障，认真做好仪

器的使用及故障记录。 

6. 仪器操作 

6.1. 系统组成及安全注意事项 

6.1.1. 系统组成及基本性能参数 

化学生物学协同筛选系统实物照片参见图 6-1，包括液体工作站(Biomek i7 

Hybrid)、纳升移液工作站(Echo 650)、高通量活细胞成像(Cytation C10)、自动化培

养箱(Cytomat450)、自动离心机(Vspin)、自动封膜机(PlateLoc)、自动撕膜机(Xpeel)、

高通量耗材储栈(Cytomat 10)、标签打印机(SciPrint)和荧光定量 PCR(QuantStudio 5)，

各模块位置参见图中序号，相关参数见表 6-1。 
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图 6-1 化学生物学协同筛选系统实物图 

 

表 6-1 化学生物学协同筛选系统组成及基本性能参数 

仪器名称 

（品牌/型号） 
主要性能参数列表 

液体工作站 

(Biomek i7 Hybrid) 

双机械臂液体处理系统： 

• 灵活 8 通道移液器：移液范围 1-250 μL（1-1000 μL 可选），精度

CV ≤7%（1 μL） 

• 96 通道加样器：移液范围 1-300 μL，精度 CV ≤5%（1 μL），配自

动清洗装置 

• 振荡模块：转速范围 0-1800 rpm 

• 温控模块：温度范围 4-100 °C 

• Pintool：可进行纳升级固定液体体积转移，96通道，266-320 nL；

384通道，108-164 nL 

• 磁珠分离模块 

纳升移液工作站 

(Echo 650) 

可进行纳升液体的精准移液： 

• 移液范围：2.5 nL-5 uL，CV≤ 8% 

• 移液速度（e.g. 384 孔板处理效率）：2.5 nL/孔：≤ 4 分钟/板；100 

nL/孔：≤ 5 分钟/板 

• 能够检测 DMSO 的水合作用并形成报告 
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• 移液软件：Cherry Pick，Plate Reformat，Dose Response 

高通量活细胞成像 

(Cytation C10) 

兼容酶标仪及转盘共聚焦成像功能 

酶标检测  ： 

• 微孔板类型：6-384 孔板 

• 检测模式：荧光检测（250-700 nm）、化学发光检测（300-700nm）、

紫外可见吸收光检测 (230-999 nm) 

• 检测方法：终点法、动力学法、光谱扫描法、孔域扫描法 

成像模式： 

• 相机：Hamamatsu Orca sCMOS，16-bit 灰度相机 

• 适配器：多功能适配器、双玻片适配器，35 mm 培养皿适配器等 

• 物镜：6 位全自动物镜转盘；物镜：4× (NA≥0.13) WD≥17 mm，

10× (NA≥0.3) WD≥10 mm，20× (NA≥0.45) WD≥7.8 mm，

40× (NA≥0.6) WD≥2.7 mm 

• 宽场显微成像：适配物镜包括 4x、10x、20x、40x，荧光通道包

括 DAPI、GFP、Texas Red、CY5 

• 共聚焦成像：适配物镜包括 20x、40x；支持 CFP、CY5、DAPI、

GFP、RFP、TRITC、明场共聚焦滤光片模块，固体激光器包含 405 

nm / 445 nm / 470 nm / 520 nm / 555 nm / 640 nm 波长 

环境控制： 

• 温度范围：室温（RT）-45 °C 

• 支持震荡 

自动化培养箱 

(Cytomat450) 

可与自动化机械臂整合 

• 温控范围：10-50 °C 

• CO2 浓度控制：0-20% 

自动离心机 

(Vspin) 

可与自动化机械臂整合 

• 速度范围：0 – 1000 g 

• 有效装载量：≤250g/离心腔 

自动封膜机 

(PlateLoc) 

可与自动化机械臂整合 

• 支持可撕的光学膜、铝膜等 

• 封膜参数可调 

自动撕膜机 

(Xpeel) 

可与自动化机械臂整合 

• 支持可撕的光学膜、铝膜等 

高通量耗材储栈 

(Cytomat 10) 

可与自动化机械臂整合 

• 兼容耗材类型：包括 SBS 规格的 96 孔板、384 孔板、枪头盒等 

标签打印机 

(SciPrint) 

可与自动化机械臂整合 

• 兼容耗材类型：包括 SBS 规格的 96 孔板、384 孔板等 

荧光定量 PCR 

(QuantStudio 5) 

• 加热模块：96 孔快速模块（0.1 mL） 

• 控温范围：4-99.9°C 

• 通道数：6 色激发光滤光片和 6 色检测光滤光片自由组合 

• 独立控温功能：相邻区域最大可以达 5 °C 

• 具备荧光内参比功能 



分
子
科
学
公
共
实
验
平
台

化学生物学协同筛选系统标准操作规程                                          第 9 页，共 54 页 

 

6.1.2. 安全须知 

6.1.2.1. 一般安全性标识  

在对仪器进行操作前，请确保您已知晓相应的安全操作规范，佩戴好手套、护

目镜等必要的安全防护措施。确保您已阅读并理解仪器操作手册所提及的安全事项。

除本文档所列举的安全注意事项外，您还应遵守实验室和实验室化学品的安全操作

规范。 

6.1.2.2. 电器安全 

始终保持仪器处于干燥状态，切勿使用湿巾等擦拭电气部件。务必确保仪器电

气连接的完好性，仅由获得授权的工作人员或具备相应资质的工作人员进行电气连

接的更改或维修。 

 

注意：张贴有此标识的模块，代表具有可移动的电气接口或供电接口。仅在需要时，

由经过培训的操作人员在断电（或特别说明）的情况下进行操作。不当的操作可能

有触电的风险，并有损坏仪器的可能性。 

6.1.2.3. 机械伤害防御 

化学生物学协同筛选系统所配备部分仪器（包括液体工作站、高通量耗材储栈、

自动撕膜机、自动封膜机、自动离心机、纳升移液模块等）均有机械伤害的风险。 

不当的错误可能会导致意外的机械性伤害，请确保在实验前、实验中及实验后

保持警惕，切勿在机械臂运行过程中将头、手伸入到仪器内部/周围的机械移动区域。

如需对仪器平台内进行操作或干预时，请务必确保机械臂处于非工作状态（关机、

停止或暂停状态） 

    

防止夹伤，化学生物学协同筛选系统中多台设备均含有机械结构和机械臂等，

其缝隙处可能会造成夹伤、卷入风险，即使在关机状态下，将手伸入到这些区域也
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是危险的。如需操作，请在厂家工程师的指导下进行操作，切勿自行操作。 

6.1.2.4. 高温伤害预防 

化学生物学协同筛选系统所配备部分仪器（包括液体工作站、封膜机、培养箱

等）均具有加热功能。过高的温度可能带来烫伤风险。 

 

高温防护：针对有加热功能的仪器，如需操作，请等待温度降至 40 ℃以下后

再操作。如需立即操作，需先在相应显示屏中查看实时温度，并在配备合适的防护

措施（例如佩戴隔热手套）下谨慎操作。 

6.1.2.5. 气体伤害预防 

培养箱使用二氧化碳进行气氛控制，如管路有泄露，除会影响实验结果外，可

能改变密闭实验室内的氧气含量，请确保实验室具有良好的通风条件。推荐使用带

有排空功能的手套箱或者带有通风罩的防护外壳。 

另外，实验过程中可能产生某些有害气体，请确保通风设施处于正常工作状态，

可以及时将有害气体排出。 

6.1.2.6. 化学品防护 

仪器平台上所使用的任何化学品，均须按照实验室化学品管理规定进行，如有

化学品洒落，请立即（仪器处于关机或暂停状态）进行清理。 

洗站、系统液、及废液桶需要定期清理，以确保最大程度上减少污染，同时保

证枪头的清洗效果。废液的处理应当符合实验室废液管理规范的要求。 

6.1.2.7. 激光安全管理规范 

 

高通量活细胞成像中含有激光器组件，请确保使用仪器时注意以下安全管理规

范。 

1) 使用相关激光设备前，请先确认已完成激光安全培训，并已与设备管理员预
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约或已取得设备操作权限； 

2) 激光部分波段工作时会发射人眼不可见的红外、紫外光，切勿认为激光器发

生故障而去用眼睛检查，如需检查激光器，请先联系设备管理员或在厂家

工程师指导下完成相关操作，务必确保激光器处于断电状态； 

3) 严禁直视激光发射口或激光在反射平面上的反射和散射光，即使佩戴了激光

防护镜，也禁止相关操作； 

4) 请注意一些波段的激光（如波长低于 430 nm 或高于 700 nm 的激光）视觉

强度会明显弱于实际强度。在使用红外激光时，由于波长>800 nm 的激光几

乎是完全不可见的，请您使用探测器或上转换片以确定激光的位置； 

5) 在使用激光时，请佩戴合适波段的激光防护眼睛，请摘掉手表、戒指、耳环

等一切可能反射或散射光线的装饰物。禁止穿着带有亮片等装饰的衣服或

非常宽松的衣服进入实验室。长发的同学在进入实验室之前请先把头发盘

好； 

6) 不可使眼睛或头部接近光路平面。如需蹲下，请先转身背对光学平台； 

7) 请使用挡光板或 beam dump 中止光路，禁止在激光路径上放置易燃、易爆

物品及黑色的纸张、皮革等燃点低的物质； 

8) 请在实验环境末端放置黑色金属板以防止激光泄露到工作区以外的空间。 

6.2. 运行准备 

6.2.1. 实验条件确认 

实验前，请确认实验所需的流程细节、加液细节（包括液体数量、液体类型、

液体种类、加液体积、加液方式等）、孔板品牌型号及板布局等相关信息，以便在培

训中与设备管理员进行针对性讨论，确认实验及优化方案。 

6.2.2. 实验项目建立 

如果涉及到整合系统的使用，在第一次试验开始时，由设备管理员先在 SAMI

软件中建立属于实验室或者项目相关的新 Project，以避免后期实验的编辑优化跟其

他用户混淆。用户需记住该 Project 名称，并在后期的使用和编辑中务必每次使用前

都确认选择自己的 Project，切勿误操作他人项目。 



分
子
科
学
公
共
实
验
平
台

化学生物学协同筛选系统标准操作规程                                          第 12 页，共 54 页 

 

6.2.3. 单机使用 

每台仪器的单机使用均需按照第 5 章节的仪器设备管理规范下相应的使用、预

约、培训、考核制度进行。完成相应仪器的培训和考核后，用户可预约使用该仪器。

仪器的实际操作流程可以参考仪器 Manual 和 SOP 附件，若有任何疑问，第一时间

联系设备管理员。 

6.3. 运行仪器  

***基理系统登陆 

接入大仪网的仪器操作电脑均需要登陆基理锁屏界面。 

(1) 如下图(a)，如界面显示“一卡通用户”，请在 Account 输入预约者的一卡通账户，

Password 栏输入相应账户密码，点击 Submit; 

注意：如账号或密码输入错误，请按键盘 Delete 键进行删除，再重新输入；禁止点

击 Cancel，否则仪器会自行关机。 

(2) 如下图(b)，如界面显示“LIMS User”，Account 显示 Administrator，请与设备管

理员联系。 

 

6.3.1. 仪器准备工作 

1) 检查液体工作站的系统液的成分和体积，按需要进行补充或更换； 

2) 确认纳升液体工作站运行正常，无黄灯或红灯报错； 

3) 打开对应的集中供气气阀，核对压缩空气主气路压力表压力为 0.72 MPa 

（105 psi）左右，CO2供气主气路压力略大约 1 Bar（14.5psi 左右），如下图所
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示； 

 

4) 检查废液桶情况，若实验前发现未排空，请及时排空； 

5) 准备好实验需要的耗材和试剂。 

6.3.2. 开机 

注意：若使用整套系统，需将所有机器依次开机；若仅使用单台设备，请按照

该机器的具体步骤开机。若有任何不确定，请先跟设备管理员联系。 

使用整合设备时，确保先开硬件再开软件，先打开液体处理工作站再依次打开

其他相关设备，具体开机细节如下。 

1） 液体工作站 

如图 6-3-1 所示，打开位于自动化液体工作站主机右侧的电源开关。若有需要，

打开其内部照明。 

 

图 6-3-1  液体工作站电源位置图示 

2） 高通量耗材储栈 

如图 6-3-2 所示，打开位于耗材储栈左侧的电源开关。 
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图 6-3-2  高通量耗材储栈电源位置图示 

3） 自动撕膜机 

如图 6-3-3 所示，打开位于仪器背面的电源开关。 

 

图 6-3-3  自动撕膜机电源位置图示 

4） 自动封膜机 

如图 6-3-4 所示，打开自动封膜机后侧电源开关。 

 

图 6-3-4  自动封膜机电源位置图示 

5） 自动离心机 
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如图 6-3-5 所示，打开自动离心机后侧电源开关。 

 

图 6-3-5  自动离心机仪器及电源位置图示 

6） 标签打印机 

一般情况下，标签打印机保持开机状态，无需开关机。 

7） 纳升移液工作站 

一般情况下，纳升移液工作站处于长时间待机的状态，无需开关机。 

注意：如有特殊情况需长时间停机，须联系设备管理员处理，用户切勿自行关机，

否则造成损坏由用户和课题组承担相应责任和损失。 

8） 高通量细胞成像系统 

如图 6-3-6 所示，打开高通量细胞成像系统的主机开关。激光器和相机一般处

于常开状态，不需要开关机。 

 
图 6-3-6  高通量细胞成像系统电源位置图示 

9） 自动培养箱 

一般情况下，自动化培养箱处于长时间待机的状态，无需开关机。 

6.3.3. 整合流程方法编辑及运行 

根据具体实验需求，实验流程可通过整合系统软件 SAMI EX Editor 软件编辑，
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下面以一个简单流程为例。 

6.3.3.1. 打开软件 

打开桌面上软件 ，进入 SAMI EX Editor 软件界面（如图 6-3-7）， 

 

 

图 6-3-7  SAMI EX Editor 软件界面图示 

6.3.3.2. 选择 Project 

点击工具栏 Project → Open…（如图 6-3-8A），选择对应课题组/项目的 Project

后（如图 6-3-8B），点击 OK， 进入窗口（如图 6-3-8C），可以在窗口左下角确认所

选 Project 的名字。确认无误后进入下一步，新建或打开方法。 

A）  

 
 

B）  
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C)   

  

图 6-3-8  SAMI EX Editor 界面打开及确认 Project 图示 

6.3.3.3. 新建方法 

点击工具栏 File → New，或者直接点击新建方法图标 。然后依次完成以下步

骤（以“将 Echo384LDV 板静置在特定位置孵育 1min30s”的流程为例）： 

1) 设置 Source Labware 

SAMI EX Editor 软件中的 Source Labware 结点是指完成实验全流程需要的所有

实验耗材，可用于定义 Source Labware（源板）、Destination Labware（目标板）和

Tip Supply（枪头）。 

在这个案例中，可在 Editor 窗口中右击任意位置，然后选择 Labware → New 

Source（如图 6-3-9A），即会出现 Labware Configuration 界面（如图 6-3-9B），可对

应输入所用板材的名字、型号等信息、内含液体体积、是否加盖等信息（此案例中
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选择 Echo_384LDV）。点击 Next 进入 Home Configuration 界面（如图 6-3-9C），在

Select Home Positions 的位置上选择 3 个板位作为初始位置。确认无误后点 OK。 

A）  

 
B)   

  
C)   

  
图 6-3-9 Labware Configuration 图示 
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2) 设置孵育的位置和参数 

在完成上述设置后，可以点击 Tutorial Source 连接的箭头尾部的 Then，从下拉

菜单中选择 Incubate Tutorial Source（如图 6-3-10A），会打开 Incubate 界面（如图

6-3-10B），用于进一步设置孵育的位置和时间。设置完成后，点击 OK，软件上会

出现对应的 Incubate 结点。 

在这个案例中，三块板将被放在 Biomek i7 上孵育。在实际实验中，可能涉及

到在堆站、培养箱或者其他地方孵育，可根据需要选择对应的孵育位置。 

A）  

 
B）  

 

图 6-3-10 Incubate 设置图示 
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3) 设置方法的结束 

在此案例中，孵育结束后，可以通过将 Tutorial Labware 送回 Home 位的方式结

束实验流程。 

可以点击 Incubate 连接的箭头尾部的 Then，从下拉菜单中选择 End → At Home

（如图 6-3-11A）。此时案例流程的编写完成（如图 6-3-11B）。这个方法会将 Echo 

384LDV 板静置在 Biomek i7 的台面上，从初始 Home 位置，移动到新的位置并在该

位置静置至少 1 分钟 30 秒，随后将板移动回到初始 Home 位置。 

A） 

 

B） 

 

图 6-3-11 方法结束设置图示 

 



分
子
科
学
公
共
实
验
平
台

化学生物学协同筛选系统标准操作规程                                          第 21 页，共 54 页 

 

4) 保存方法 

确认无误后，点击工具栏 File → Save，可打开 Save Method 窗口（如图 6-3-12）。

确保左侧的 Projects 清单中，正确的 Project 被选中（在此示例中应是 Tutorial 被选

中），然后在 Name 的位置输入相应的方法名称（在此实例中为 Tutorial 1），点击 Save

即可完成方法的保存。 

至此，新建方法案例（“将 Echo384LDV 板静置在特定位置孵育 1min30s”）编

写完成并保存，可用于后续调用和运行。 

 
图 6-3-12 方法保存图示 

6.3.4. 程序运行 

6.3.4.1. 打开方法 

打开软件 ，点击工具栏 File → Open（如图 6-3-13A），选择需要运行

的方法程序，点击 OK, 得到如图 6-3-13B。 
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A） 

 
B) 

  

图 6-3-13  打开方法图示 

6.3.4.2. 预约方法（Schedule） 

运行方法前，需对方法进行 Schedule。若有多个 Family 同时进行，可输入相应

的数字后 Schedule。 

注意：在每次运行方法前（尤其是对方法做了部分修改后），一定要再次点击

Schedule，否则会按照前一次 Schedule 的方法运行。 

具体操作中，首先确认软件界面显示的方法无误，然后点击工具栏 Schedule，

会打开 Schedule Setup 界面（如图 6-3-14A）。以 6.3.3 章节中的方法 Tutorial 1 为例，

可运行的 Families 的最大数量为 3，可根据实验需求，输入 1、2、3 中相应数字（此
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处以 3 为例），然后点击 Schedule。 

软件处理完成后显示 Schedule Succeeded 窗口（如图 6-3-14B），以及系统推算

的时间。此时可以通过点击本窗口右侧的 View Schedule 打开 See It！窗口（如图

6-3-14C），可看到该方法运行的甘特图，了解具体步骤及时间顺序。 

A)  

 
 

B) 

 
 

C)  

 

图 6-3-14  Schedule 相关设置图示 

6.3.4.3. 方法运行 

成功完成方法预约（Schedule）后，SAMI EX Editor 软件工具栏上的运行按钮

Run 会从灰色变成绿色（如图 6-3-15A），点击 Run，进入 SAMI EX Runtime 软件界

面（如图 6-3-15B）。 
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A)    

 

B)    

 

C) 

  

D)  

 

图 6-3-15 SAMI EX Editor 软件及 SAMI EX Runtime 软件界面 
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若是当日首次进入 SAMI EX Runtime 界面，需要先手动初始化仪器。点击工具

栏上的 Manual Control（如图 6-3-15C），在下拉菜单中依次选择相应模块，分别进

行初始化，包括“Biomek_i7”、“Centrifuge”、“Cytation_C10”、“Cytomat10”、

“Cytomat450”、“Delidder01”、“Echo”、“InhecoSingleTEC1”、“PlateLoc”、“SciPrint”、

“XPeel”。以离心机为例（如图 6-3-15D），在 Action 的下拉菜单中选择“Initialize”

后，点击“Run Now”。 

注意：初始化时，请保证所有仪器和台面上没有耗材和试剂，以避免初始化过程中

出现故障。 

手动初始化成功后，可点击工具栏的运行图标 ，进入 Add Labware 

Confirmation 窗口（如图 6-3-16A），可点击 Labware Addition Report 打开相应的耗材

摆放报告（如图 6-3-16B）。 

确认耗材全部摆放无误后，可以点击 Finished，系统会立即自动开始运行方法。

若有任何问题需要修改，可点击 Abort 后，关闭 SAMI EX Runtime，返回 SAMI EX 

Editor 修改后，重新保存、Schedule、运行。 

注意：在运行方法过程中，出现任何问题和报错，请第一时间联系设备管理员进行

相关处理，用户切勿贸然自行处理。 

A） 
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B) 

 

图 6-3-16  SAMI EX Runtime 软件耗材添加界面图示 

6.4. 数据查看 

针对整合实验，实验结束后，可以在 Dart Data Browser 软件中浏览相关信息和

数据。 

针对单机实验，可根据附件说明在相应的电脑和文件夹中查找所需报告。 

 

图 6-4-1 Dart Data Browser 软件界面 
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6.5. 实验结束操作 

6.5.1. 关机 

实验结束后，先关闭软件（SAMI），再依次关闭硬件电源开关，包括液体工作

站、高通量耗材储栈、自动撕膜机、自动封膜机、自动离心机、高通量细胞成像系

统的主机（不包括相机和激光器）。 

注意：一般情况下，纳升液体工作站、标签打印机、和高通量成像系统的激光和相

机无需关机。如需经历长假期，请直接联系设备管理员，切勿自行关机。 

6.5.2. 其他 

1) 整理实验台面，清理实验过程中产生的废弃物，包括吸头、孔板、废液等，

并按照合理分类放入相应垃圾桶。仪器平台上所使用的任何化学品，均须按照

实验室化学品管理规定进行，如有化学品洒落，请立即（仪器处于关机或暂停

状态）进行清理。废液的处理应当符合实验室废液管理规范的要求。 

2) 退出基理账号。 

3) 完成实验登记。 

7. 相关/支撑性文件 

Q/WU FLHR001 文件编写规范。 

8. 附件 

附件 1 Echo Dose-Response 简易操作说明 

附件 2 Echo Plate Reformat 简易操作说明 

附件 3 Echo Cherry Pick 简易操作说明 

9. 记录 
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附件 1 Echo Dose-Response 简易操作说明 

Echo® Dose-Response 简易操作说明 

 
Echo® Dose-Response 应用程序可通过编辑方法，驱使 Echo 移液系统执行一个

或多个移液步骤，主要用于将特定浓度的化合物稀释成多个浓度用于后续相关实验，

例如 IC50 Assay。 

以 IC50 Assay 板准备为例，Echo® Dose-Response 应用程序编辑的步骤如下所示： 

 

 

程

序

编

写 
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使用 Echo® Dose-Response 应用程序，先双击图标 打开该程序后，按照如下

流程进行方法编辑。 

1. 规划曲线 

编辑 Echo® Dose-Response 应用程序需用预先获知以下信息： 

a) 样品起始浓度 

b) 来源板布局 

c) 中间板布局 

d) 最终 assay 体积 

e) Dose-Response 曲线中的浓度点的数目 

2. 程序编写 

在创建应用程序方案时，这些步骤十分关键。孔板格式 Plate Format 的选择决定应

用程序所用实物板的参数。孔板类型 Plate Type 的选择决定 Echo 移液系统所用的转移

方法；同时也需要考虑孔板格式和流体特性相匹配，以保证准确的液体转移。 

a) 创建新方案 

可通过在 File 菜单中选择 New，或者单击工具栏中的 New 图标 ，创建新方案。 
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b) 创建来源板 

i. 单击 Protocol 窗口中的 Plate Template Actions 部分的 Add Source，启动 Source 

Plate Designer 向导。 

ii. 在该向导的新窗口中根据实际实验计划选择 Source Plate Format。（注：来源

板只能是 Echo 指定的孔板，包括 1536LDV，384LDV，384PP。） 

iii. 选择第一个样品所在孔，单击 Selection Actions 部分中的 Sample 按钮。在 

Sample Definition对话框中输入样品编号、样品浓度和单位。在Plate Type下拉

菜单中选择板和液体类型。 

 

iv. 单击 OK，关闭 Sample Definition 对话框。被指定的孔将变为红色并被标记为 a。 

v. 重复以上步骤，在孔板上添加剩余样品。可以在来源板上添加对照品，按照样

品的Dose-Response曲线创建流程创建参考曲线。还可以在来源板上添加溶剂，

用于稀释目的板中的样品和对照品。 
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vi. 确认无误后点击 Next。显示下一个屏幕，在 Template Name 输入来源模板名

称。单击 Finish 关闭 Source Plate Designer 对话框。来源板定义结束。Plate 

Design 选项卡将显示该来源板的设计。 

 

c) 使用“Protocol Generator”创建中间板和目标板 

创建来源板之后，可以使用 Protocol Generator 向导，通过设置样品和溶剂回补的体

积要求，规划曲线数据。向导将引导曲线数据的参数选择，定义中间板生成参数和目标
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曲线参数。使用向导创建方法后，用户可以通过重新运行向导或编辑每块来源板、中间

板或目标板的各个数值，进行方法修改。 

 

i. 单击 Protocol 窗口中 Plate Template Actions 部分的 Protocol Generator，启动 

Protocol Generator 向导。该向导将显示已经创建的来源板中的样品和对照品浓

度，请确认与来源板中定义的一致。 
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ii. 在 Intermediate Template Information 中根据实验设计和需求选择 Plate Format、

Plate Type。（注：中间板只能是 Echo 指定的孔板，包括 1536LDV、384LDV、

384PP。） 

iii. 在 Bulkfill Volume Calculation Mode 部分选择 Automatic 或 Fixed，从而定义补

充液的加液方式。 

iv. 在 Intermediate Template Information 部分分别设置 Per Point Maximum Transfer 

Volume、Max number of intermediate templates（最大允许值为 10）、Max number 

of concentrations per template。 

v. 单击 Next 转到 Protocol Generator Wizard 的第 2 页。 

 

vi. 在 Destination Curve Parameters 部分依次填入： 

⚫ Added Assay Reagent Value：设为每个目标孔即将添加的体积。 

⚫ Per Point Maximum Transfer Volume：每点最大移液体积。 

⚫ Maximum Solvent Percentage：最大溶剂百分比。 

⚫ Per Point Concentration Tolerance：表示允许的理论浓度最大误差。 

⚫ Replicates per plate：同一块板上的复孔数量。 

⚫ Destination Plate Copies：目标板的重复数。 
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vii. 在 Destination Curve Parameters 部分将 Curve Type 设为 Custom（在 Theoretical

选项卡中手动定义曲线）或 Fold-based（基于其他填入的相关参数定义曲线）。

若选用 Fold-based，则需依次填入以下信息用于浓度曲线的计算： 

⚫ Starting Concentration：第一个理论浓度。 

⚫ Dilution Factor：稀释倍数。 

⚫ Data Points：Dose-Response 曲线中的数据点数量。 

viii. 单击 Generate Table，对应下方窗口中的 Theoretical、Actual 和 Curve Display

选项卡均会更新。若上述参数有任何修改，请再次点击 Generate Table 以确保

相应选项卡里的数据能够反映修改后的参数。与此同时，每块中间板还会新创

建一个对应选项卡。 

ix. 在 Automatic Backfill 部分，可根据实验需求，将 Perform Backfill 设为 First、

Last 或 None。 

x. 单击 Next 转到 Protocol Generator Wizard 第 3 页，若设计将 Bulk-fill fluid 放置

在中间板中，可在此步骤根据溶剂性质设置其孔位、体积、和 Plate Type，单

击 OK 完成设置。 
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xi. 确认无误后单击 Next，进入中间板的命名及板布局确认（如上图），确认无误

点击 Next 进入目标板创建。 

xii. 根据实验需求，依次选择 Destination Plate Type、板布局、预留孔位，完成目

标板的创建，确认无误后点击 Next。 
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xiii. 程序会给出相应的目标板板布局，填入 Template Name 并确认板布局后，点击

Finish 完成目标板创建并退出 Protocol Generator Wizard。 

 

xiv. 若要编辑或删除来源板、中间板或者目标板，请选中 Plate templates in this 

protocol 窗口下对应的孔板，单击 Edit 打开对话框编辑，或者单击 Delete删除。 
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d) 创建固定板（如需） 

固定板模板主要用于对转移至目标板的对照品和/或溶剂进行设置。 

i. 单击 Protocol 窗口中的 Plate Template Actions 部分的 Add Fixed Plate，Fixed 

Plate Designer 向导。 

 

ii. 在该向导的新窗口中根据实际实验计划选择 Source Plate Format。根据实验需

求，按照如来源板中添加样品的相同方式，添加相应的 Control 和 Solvent。添

加完毕后，点击 Next。（注：固定板只能是 Echo 指定的孔板，包括 1536LDV，

384LDV，384PP。对应的 Control 必须填入名称）。 
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iii. 在 Template Name 输入固定板名称。单击 Finish 关闭 Fixed Plate Designer 对话

框。固定板定义结束。Plate Design 选项卡将显示该来源板的设计。 

 

iv. 若要编辑或删除固定板，请选中 Plate templates in this protocol 窗口下的 Fixed

中对应的固定板，单击 Edit 打开对话框编辑，或者单击 Delete 删除。 

 

 

e) 保存方案 

选择 File 菜单中的 Save，或者直接在工具栏中点击 Save 图标 。 



分
子
科
学
公
共
实
验
平
台

化学生物学协同筛选系统标准操作规程                                             第 39 页，共 54 页 

 

3. 运行方案 

完成来源板、中间板、固定板（如果适用）和目标板的移液图之后，可在 Echo 系

统上运行方案或模拟运行方案。如果已经保存，可以直接点击运行 ；如果没有，点

击运行时会提示保存，保存后再进入 Run Options 窗口。 

若进行模拟运行，在 Run Options 窗口中，直接点击 Simulate。 

若进行系统运行，需选择对应的 Instrument，在 Order ID 上输入对应“实验室/项目

名称缩写-使用人姓名缩写”（例如：ISCMS-JD）。选择待制作目标板(Destination Plate)

拷贝数量 Plate Copies 以及复孔数量。单击 Plate Calculator 按钮可查看此次运行期间将

处理的各类板的数量。确认无误后，单击 Run 进入 Run Status 窗口。单击 Start 开始执

行方案。方案运行结束时，单击 Close 退出 Run Status 窗口。 

 

4. 管理移液数据，查看报告 
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移液运行结束时，Echo® Dose-Response 应用程序可创建移液报告，并将其存储于

以下位置标记日期的文件夹内：C:\Labcyte\Echo\Reports\Echo Dose-Response 

5. 实验结束，请整理实验台面，退出基理账号并在实验记录本上登记相关信息。 
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附件 2 Echo Plate Reformat 简易操作说明 

Echo® Plate Reformat 简易操作说明 

 

Echo® Plate Reformat 应用程序可 Echo 移液系统提供多种板式移液功能，可自定

义移液从来源板特定区域转移到目标板的指定区域的任意分布。 

利用 Echo® Plate Reformat 应用程序创建标准移液方案的步骤如下所示： 

 

 

使用 Echo® Plate Reformat 应用程序，先双击图标 打开该程序后，按照如下

流程进行方法编辑。 
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1. 创建新方案 

可通过在 File 菜单中选择 New，或者单击工具栏中的 New 图标 ，创建新方案。 

2. 选择来源板和目标板类型 

在创建应用程序方案时，这些步骤十分关键。孔板格式 Plate Format 的选择决定应

用程序所用实物板的参数。孔板类型 Plate Type 的选择决定 Echo 移液系统所用的转移

方法；同时也需要考虑孔板格式和流体特性相匹配，以保证准确的液体转移。 

a) 在 Protocol Setup 窗口中，设置 Source Plate 的相关信息： 

i. Plate Format：根据实验计划，选择 384PP、384LDV 或 1536LDV。 

ii. Default Plate Type：基于选好的 Plate Format，将会出现兼容的板类型作为

（默认板型），根据液体类型，设置 Default Plate Type。 

b) 在 Protocol Setup 窗口中，设置 Destination Plate 的相关信息： 

i. Plate Type：根据实验中计划使用的板型进行选择。 

 

3. 选择图模式 

有两种可用的图模式：区域性或自定义。按照以下规则为基础，选择区域性（复制、
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压缩或 解压缩）或自定义，并单击 OK。 

a) 区域性图模式（Regional） 

以下为三种预定义的图模式描述。 

i. Replicate：用户可选择复制部分或整块板。 

ii. Compress：用户可选择将部分或整块 384 孔板压缩为 1536 孔板格式。 

iii. Decompress：用户可选择将部分或整块 1536 孔板解压缩为 384 孔或 96 孔目

标板。 

b) 自定义图模式（Custom） 

最常创建的自定义图模式如下所示：  

i. Transfer region：可从来源板中的任意区域转移任意体积至目标板中的任意区

域。 

ii. Replicate：从来源板的一个区域复制至目标板内的多个区域。 

iii. Interleave：从来源板的一个单独区域转移样品至目标板的交错区域中。 

iv. Pool：将不同来源板或同一来源板不同区域中的样品转移至目标板中的相同

区域。 

v. Transpose：转置被转移的区域。例如，从水平区域转为垂直区域。 
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4. 添加区域 

 

从来源板向目标板添加区域： 

a) 在 Protocol Plates 下拉菜单中选择 Source，并在来源板中选择将被转移至目标

板的区域。 

b) 在 Destination Plate 中选择区域用于接收转移自来源板的区域。 

c) 在 Region Information 对话框内输入 Volume (nL)。 

d) 单击 Region Information 对话框内的 Add Region（添加区域），或单击工具栏中

的 Add Region（添加区域）图标 。 

Echo® Plate Reformat 应用程序将根据所选的区域和体积分配来源板与目标板中的

孔和体积。 

5. 添加固定板（如需） 

在完成区域性或自定义移液图后，运行方案内可支持加入一个固定板。固定板通常

用于从一个公共板向每个目标板添加对照品。 

使用固定板这一选项，向样品板添加对照品步骤如下： 
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a) 在 Protocol Plates 下拉菜单中选择 Fixed。根据实验需求，选择 Before Source 

Plate 或 After Source Plate 选项。单击 Add Plate 添加固定板。 

b) 在 Fixed Plate Setup 窗口中，选择 Default Plate Type 并单击 OK。 

 

c) 在 Protocol Plates 下拉菜单中选中新的 Fixed Plate，设置固定板的相关信息。 
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d) 选择板图中装有对照品的孔，并在 Destination Plate 中选择用于接收对照品的

区域后，单击 Region Information 对话框中的 Replicate Region。Echo® Plate 

Reformat 应用程序将根据所选的区域和体积分配固定板与目标板中的孔和体

积。 

 

6. 保存方案 

选择 File 菜单中的 Save，或者直接在工具栏中点击 Save 图标 。 

7. 运行方案 

完成来源板、固定板（如果适用）和目标板的移液图之后，可在 Echo 系统上运行

方案或模拟运行方案。如果已经保存，可以直接点击运行 ；如果没有，点击运行时

会提示保存，保存后再进入 Run Options 窗口。 

若进行模拟运行，在 Run Options 窗口中，直接点击 Simulate。 
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若进行系统运行，需选择对应的 Instrument，在 Order ID 上输入对应“实验室/项目

名称缩写-使用人姓名缩写”（例如：ISCMS-JD）。选择待制作目标板（Destination Plate）

拷贝数量 Plate Copies。单击 Plate Calculator 可查看此次运行期间将处理的各类板的数

量。 

确认无误后，单击 Run 进入 Run Status 窗口。单击 Start 开始执行方案。方案运行

结束时，单击 Close 退出 Run Status 窗口。 

8. 查看报告 

移液运行结束时，Echo® Plate Reformat 应用程序可创建移液报告，并将其存储于

以下位置标记日期的文件夹内：C:\Labcyte\Echo\Reports\Echo Plate Reformat 

9. 实验结束，请整理实验台面，退出基理账号并在实验记录本上登记相关信息。 



分
子
科
学
公
共
实
验
平
台

化学生物学协同筛选系统标准操作规程                                             第 48 页，共 54 页 

 

附件 3 Echo Cherry Pick 简易操作说明 

Echo® Cherry Pick 简易操作说明 

 

Echo® Cherry Pick 应用程序为 Echo 移液系统提供各种各样的孔板移液功能。转移

方案对导入选择列表的孔板参数和处理顺序进行定义。选择列表用于将选中的样品从来

源板自动转移到目标板。选择列表可在方案创建期间或在运行前导入。转移结束后在自

定义报告中报告最终孔位。 

利用 Echo® Cherry Pick 应用程序创建典型的移液方案步骤如下： 

 

 

使用 Echo® Cherry Pick 应用程序，先双击图标 打开该程序后，按照如下流

程进行方法编辑。 
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1. 创建新方案 

在 File 菜单中选择 New，或者单击工具栏中的 New 图标 ，创建新方案。 

2. 选择来源板和目标板类型 

在创建应用程序方案时，这些步骤十分关键。孔板格式 Plate Format 的选择决定应

用程序所用实物板的参数。孔板类型 Plate Type 的选择决定 Echo 移液系统所用的转移

方法；同时也需要考虑孔板格式和流体特性相匹配，以保证准确的液体转移。 

 

a) 在 Protocol 选项卡的 Source Definitions 区域中，设置来源板参数： 

i. Sample Plate Format：根据实验设计选择 384PP、384LDV 或 1536LDV。 

ii. 选定孔板格式后，Sample Plate Type 出现兼容的孔板类型，从列表中选择适

当的 Sample Plate Type。 

iii. 如果选择列表未指定样品体积，请输入 Sample Volume。（注：如果选择列表

已指定一个样品体积，则选择列表的样品体积将覆盖此处设置的样品体积。） 
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iv. Control Plate Format（可选）：若实验设计中有 Control Plate，可按照如上的

同样方式，设置相应的板参数，包括 Control Plate Format、Control Plate 

Type、Control Volume。 

b) 在 Protocol 选项卡的 Destination Definition 区域中，设置目标板参数： 

i. Destination Plate Type：选择实验设计对应的目标板类型。（注：并非所有仪

器都提供全部孔板格式和孔板类型。若用户的实验设计中涉及到新的孔板，

请在实验前联系仪器管理员进行孔板添加和测试，以确保仪器安全和移液的

精准度。） 

3. 设置转移方案 

完成上述板参数之后，设置其他转移方案参数。 

 

a) 在Process controls in this protocol区域中，根据实验需求，选择以下选项，定义

孔板的处理顺序。 

i. At the end of the run：先处理所有样品选择列表的孔板，最后加对照品。 

ii. At the end of each destination plate：在每块目标板结束时添加对照品。 
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b) Optimize transfer throughput：优化转移通量。 

c) Plate copies：孔板计划复制的次数。 

d) Next Available Well Mode： 

i. Replicates per plate：复孔数量。 

ii. In Adjacent Wells：复孔彼此相邻。 

iii. Fill Direction (Across or Down)：目标板上的填充方向为横向或纵向。 

注：只有选择列表中未定义目标孔时，才应用 Next Available Well Mode 的设置。 

e) 如果需要预留孔，请选择目标板图中的孔并单击 Reserved。在样品转移过程中

应用程序将跳过预留孔。 

注：如果选择列表定义了目标孔，则预留孔会被忽略。 

4. 创建或导入选择列表 

创建选择列表可参考程序自带的默认列表，选择列表必须保存为 .csv 或 .txt 文件

格式，Echo® Cherry Pick 应用程序才能够使用。（注：请务必将该选择列表模板复制到

自己的文件夹中再进行修改，切勿直接在原始系统文件夹中修改）。 

Echo® Cherry Pick 的默认选择列表有如下三种： 

⚫ 384-384_NextAvailableWell.csv：只需来源板条码和来源孔位置。在方案设置

中，用户可以指定多个孔板拷贝和多个样品重复。样品被转移到目标板的下一

个可用孔中。 

⚫ 384-384_Explicit.csv：此选择列表明确指定目标孔位置、目标板 ID 和转移体

积。在方案设置中，板拷贝和样品重复必须设为 1。 

⚫ 384_Controls.csv：此选择列表明确用于对照品，指定来源板条码、来源孔和目

标孔位置以及转移体积。此列表可以与 NextAvailableWell、Explicit 选择列表

一起使用。 

导入选择列表的步骤如下： 

a) 导航到 Pick List 选项卡，单击 Samples 选项卡中的 Import，选择 Open Pick List

对话框中已经创建完成的选择列表。 

b) 单击 Open 打开所需选择列表显示 Import Pick List 对话框。根据需要修改选择

列表参数，然后单击 Import，选择列表被导入方案中。 
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c) 导航到 Controls 选项卡，重复以上流程，导入对照品选择列表。（此步骤为非

必需项。） 
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d) 导航到 Plate Preview 选项卡中查看来源板和目标板。 

 

5. 保存方案 

选择 File 菜单中的 Save，或者直接在工具栏中点击 Save 图标 。 

6. 运行方案 

创建转移图并导入样品选择列表之后，可在 Echo 系统上运行方案或模拟运行方案。

如果已经保存，可以直接点击运行 ；如果没有，点击运行时会提示保存，保存后再

进入 Run Options 窗口。 

若进行模拟运行，在 Run Options 窗口中，直接点击 Simulate。（注意：若要模拟运

行，需选中 Pre-process pick lists in the order specified。） 
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若进行系统运行，需选择对应的 Instrument，Order ID 上输入对应“实验室/项目名

称缩写-使用人姓名缩写”（例如：ISCMS-JD）。选择待制作目标板（Destination Plate）

拷贝数量 Plate Copies 和复孔数（注：此处的更改将覆盖方案中的相应设置）。单击 Plate 

Calculator 可查看此次运行期间将处理的各类板的数量。 

如果之前未导入样品列表/对照品列表，或者想更改已经导入的当前选择列表，可

通过 Source Plate 区域导入相应列表。 

确认无误后，单击 Run 进入 Run Status 窗口。单击 Start 开始执行方案。方案运行

结束时，单击 Close 退出 Run Status 窗口。 

7. 查看报告 

移液运行结束时，Echo® Cherry Pick 应用程序可创建移液报告，并将其存储于以

下位置标记日期的文件夹内：C:\Labcyte\Echo\Reports\Echo Cherry Pick 

8. 实验结束，请整理实验台面，退出基理账号并在实验记录本上登记相关信息。 




